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Introduction to IApioneer v3.0.3 

“Know the Earth – measure the way™” 
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Introduction Page for the instructor 

 

2 

9/21/2015 

UNCLASSIFIED 



I A V O  R E S E A R C H  A N D  S C I E N T I F I C  

®2015 IAVO Research and Scientific 

UNCLASSIFIED 

Session 1 Session 2 

Module 1: Application Configuration 
& Data Management 

Hands on Demo 

Module 2: IApioneer 
 

Q & A 

Module 3: 3D Modeling 
 

Lunch Break 
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Module 1: Application Configuration & Data 
Management 
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Mouse Control (Pan Mode) 

Mouse buttons: 

• Left: 

– Click is the primary button for all actions. 

– Click and Dragging: 

• In the viewer will enable selection box mode. 

• A selected object, will allow for moving of the 
selected object. 

• Mouse wheel: 

– Roll will zoom in and out.  

– Click will reposition the image to the center of 
the viewer for the point of the click. 

– Click and Dragging will grab the image and allow 
for it to move with the cursor. 

• Right click: 

– Will display the context menus.  

– Will end the active drawing mode. 
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Mouse Control (Roam Mode) 

Mouse buttons: 

• Left: 

– Click is the primary button for all actions. 

– Click and Dragging: 

• In the viewer will enable the selection box mode. 

• A selected object, will allow for moving of the 
selected object. 

• Mouse wheel: 

– Roll will zoom in and out.  

– Click will cause the image to move smoothly away 
from the cursor for the duration of the click. 

– Click and Dragging will cause the image to move 
smoothly away from the cursor for the duration 
of the hold. 

• Right click: 

– Will display the context menus.  

– Will end the active drawing mode. 
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Main Application  

Elements of the User Interface: 

1. The Ribbon 

2. Left Viewer 

3. Right Viewer 

4. Image Gallery 

5. Layer Manager 
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Elements of the User Interface (UI) 

Components of the UI: 

1. The Ribbon – The tabs of the Ribbon organize capabilities by module, allowing the user to 
interact with the data in a logical manner.  The Home tab contains all of the camera and 
image viewing tools, including; zoom, rotation, brightness, contrast, and histogram 
adjustments.  Each of these is applied to the active viewer only.  In addition to the Home 
tab, each licensed processing module may add one or more tabs to the Ribbon. 

2. Left Viewer – One of the two primary viewers used to interact with the data.  Images can 
be sent to the Left Viewer from the Image Gallery.  Data layers (vectors, tie points, and 
annotations) can be displayed from the Layer Manager. 

3. Right Viewer – One of the two primary viewers used to interact with the data.  Images can 
be sent to the Right Viewer from the Image Gallery.  Data layers (vectors, tie points, and 
annotations) can be displayed from the Layer Manager. 

4. Image Gallery –Thumbnails of the raster data loaded in the current session are displayed 
here.  Images can be added to the Left or Right Viewers by right-clicking on the thumbnail 
in the Image Gallery and selecting “Send to Left Viewer” or “Send to Right Viewer”. 

5. Layer Manager – Vector, tie point, and annotation layers loaded in the current session are 
listed here.  Each has a checkbox to indicate whether or not it is displayed in the viewers, 
and a radio button to select the actively editable layer. 
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Application Configuration 

This section will illustrate how to setup your production environment for 
product generation. You will be exposed to various tools to assist you in 
simplifying your workflows. This will also allow for a user or organization to 
modify and define a Common Operational Picture (COP) for a product. 
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Backstage 

Data loading and system parameters are accessed through the Backstage.  

Capabilities within the backstage: 

• Image management (Add and Remove) 

• DEM management (Add, and Remove) 

• Vector management (Add, Remove, and Save) 

• Tie Point management (Add, Remove, and Save) 

• Annotation management (Add, Remove, and Save) 

• Session management (Save, Save As, Open, and Close) 
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Navigating to the Backstage 

Left click the “File” tab to navigate 
to the backstage. 
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Backstage - Overview 

Elements of the backstage: 

1. Commands 

2. Images  

3. DEMs 

4. Vectors 

5. Tie Points 

6. Annotations 
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Loading data into your session  
from the backstage 

The application supports a number of 
different types of data, including: 
satellite imagery, aerial imagery 
(scanned film and digital images), 
orthographic images, DEMs, 2D and 3D 
vectors, tie points and annotations.  

1. Left click the [Load Data] button.  

2. Left click any supported data file(s). 

3. Left click the [Open] button to load the 
selected data. 
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Loading data continued 

Things to watch for when data is loaded into the session for the first time: 
 

• A pyramid (R-Set) warning icon will be overlaid on the image icon for all 
raster images without pyramids. You will have minimal functionality for 
those images, until the pyramid for that image is generated. A Pyramid will 
be generated automatically, for optimal viewing quality, for raster images 
without pyramids. The pyramid warning icon overlaid on the image icon 
will disappear, once the pyramid is generated.  Large images may take 
some time to load, especially large vector sets. Please be patient, the 
images will appear in the Session shortly. 
 

• A Spatial Referencing System (SRS) warning icon will be overlaid on the 
image icon for all raster images that the SRS have not been configured. 
You will have to configure the sensor model to ensure the correct 
alignment of the images. The sensor model warning icon will disappear, 
once the sensor model has been configured. 
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Digital Elevation Model (DEM) 

Wait a minute!  

I thought I selected a DEM when I loaded the 
images. Why is it not showing in the DEMs section?  

In this case we have selected a TIFF DEM. However, 
there is a simple fix for this. We need to let 
IApioneer know that this raster file is a DEM.  

Identify a raster image as a DEM: 

1. Left click the image that you want to identify as a 
DEM. 

2. Right click the selected image from step 1. 

3. Left click the [Properties] menu item from the popup 
menu. 

4. Left click the [Image] button causing the text to 
toggle between “Image” and “DEM’. Make sure it is in 
the DEM state. 

5. Left click the [OK] button to commit the change. 

* The selected image should have moved from the 
Images group to the DEMs group. 
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Batch Aerial Workflow 

Aerial imagery is often acquired in large 
batches, either from a set of flight lines 
or from some other pre-specified flight 
path. Batch Aerial workflow will 
eliminate the manual editing of each 
individual sensor model. You will be 
required to provide the Interior 
Orientation (IO), projection, and Exterior 
Orientation (EO) to complete the 
workflow. 

 

Left click the [Batch Aerial Workflow] 

button to start the process. 
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Batch Aerial Workflow –  
Interior Orientation Setup 

The initial screen in the workflow is 
collecting the Interior Orientation. 
Figure 1 is an example of the IO for the 
Raleigh demo data. Figure 2 is the initial 
screen that allows you to input the 
information from Figure 1. 
 

Left click the [Next] button to proceed 
to the projection & Exterior Orientation 
screen. 
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Batch Aerial Workflow –  
Projection & Exterior Orientation  

Setting the projection: 
1. Left click the [Change] button. 
2. Define the Spatial Referencing: 

– Projection: State Plane 
– Datum: NAD83 
– Linear Unit: U.S. Foot 
– Angular Unit: Degree 
– State Plane: North Carolina (3200) 

3. Left click the [OK] button on the Spatial 
Referencing Dialog. 

4. Select the appropriate file format for 
the EO file: 
– File Format: “ImageID X Y Z Omega 

Phi Kappa” 
5. Left click the […] button.  
6. Left click the EO file and then left click 

the [Open] button. 
7. Left click the [Next] button to proceed 

to the data pairing form. 
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Batch Aerial Workflow –  
Data Pairing 

Data pairing is the process of taking all 
of the values from the earlier steps and 
configuring the sensor models for each 
image.  
 

The Image Id is used to identify the 
image loaded into the project and pairs 
them automatically.  

You can still change the image pair: 

1. Left click the new image name within 
the image name dropdown.  

2. Left click the [Next] button to process 
the batch and update the sensors for 
all of the paired images. 
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Saving Imagery Metadata 

You will need to save the changes to the 
images metadata or you will be required 
to reconfigure the SRS system when the 
image is loaded.  
 

Saving the imagery metadata: 

1. Left click the first image in the “Images” 
group. 

2. Hold down the shift key. 

3. Left click the last image in the “Images” 
group. 

4. Right click on one of the selected image 
in the “Images” group. 

5. Left click the [Save Metadata] menu 
item. 
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Vectors 

The Vectors header, in the Backstage, is 
the managing tool for all vector layers. 
Vector layers are individual documents 
within 3D FeatureXTract that stores your 
layer geometry.  

Creating a new vector: 

• Left click the [Add Vector Layer] button. 

The new vector layer should display with 
the name of “Unnamed Feature Set #”. 
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Vector - Saving 

Lets make sure that we don’t lose the 
new vector file and provide it a more 
defined name.  
 

Saving a new vector layer: 

1. Left click the “Unnamed Feature Set 2*” 
file to select it. 

2. Right click the “Unnamed Feature Set 
2*”  to display the popup menu. 

3. Left click the [Save Data] menu item. 

4. Type “Raleigh” as the new File Name. 

5. Left click the [Save] button. 
 

The “Unnamed Feature Set 2” should 
have updated to Raleigh.gvf when you 
return to the backstage.  
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Annotations 

The Annotations header, in the 
Backstage, is the managing tool for all 
annotation layers. Annotation layers are 
individual documents within IApioneer.  
 

Creating a new Annotation: 

• Left click the [Add Annotation Layer] 
button. 

 

The new annotation layer should display 
with the name of “Unnamed Annotation 
Document #”. 
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Annotation - Saving 

Lets make sure that you don’t lose the 
new annotation file and provide it a 
more defined name.  
 

Saving a new annotation layer: 
1. Left click the “Unnamed Annotation 

Document 2*” file to select it. 
2. Right click the “Unnamed Annotation 

Document 2 *”  to display the popup 
menu. 

3. Left click the [Save Data] menu item. 
4. Type “Raleigh” as the new File Name. 
5. Left click the [Save] button. 
 

The “Unnamed Annotation 
Document 2 ” should have been 
updated to Raleigh.gad when you 
return to the backstage. 
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Session - Saving 

The data loaded in the application is managed by a 
Session. Currently, the application supports a single 
session workspace. The Session files will reduce 
your preprocessing time drastically. A session will 
take only a few clicks to load all of the data 
associated within that current workspace. You will 
be back up and running in no time. 
 

Saving a session: 

1. Left click the [Save Session] button. 

2. The “Save Data” dialog should display identifying that 
we have unsaved data in the session.  

3. Left click the [Yes] button to save all files. 

4. The “Save Session” dialog should display. Type 
“Raleigh” as the File Name. 

5. Left click the [Save] button.  

 

*The title bar of the application should display 
IApioneer - Raleigh.xpj. 
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Settings 

The application was built to be 
customizable. This will allow for a user 
or organization to modify and define a 
Common Operational Picture (COP) for a 
product. The COP ensures that all 
products are consistent with look and 
content.  

 

Left click the [Settings] button. 
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Settings – Geolocation Formats 

The Geolocation Formats properties provides 
you with the ability to configure how map 
information is displayed and entered. The 
Display format properties controls how map 
coordinates are displayed. The Input Format 
properties provides the template for a user-
derived information. 
 

Modifying the Geolocation Formats: 

Display Format: 

– Projection Type: Geographic 

– Geographic String Format: DDD.D 

– Vertical Datum: Ellipsoid (WGS84) 

– Vertical Units: Foot (US) 

Input Format: 

– Projection Type: Geographic 

– Geographic String Format: DDMMSS.S 
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Settings – Measurement 

The Measurement properties provides 
you with the ability to configure how all 
measurements are displayed 
throughout the application. The 
measurement units can be specified for 
Length, Area, and Angles. 
 

Modifying the Measurement: 

• Length: Foot (US) 

• Angles: Radians 

• Area: Acres 
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Settings – Data Discovery 

The Data Discovery property is where 
you specify the local and remote 
directories to use for the Data Discovery 
search routines. Add or remove 
directories from this dialog  

 

Adding a directory: 

1. Left click the [Add] button. 

2. Select the local “Demo Data” root 
directory. 

3. Left click the [OK] button in the “Browse 
For Folder” dialog. 
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Settings – Data Discovery  
continued 

Removing a directory: 

1. Left click the local “Demo Data”. 

2. Left click the [Remove] button. 
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Settings – Terrain 

The Terrain property is where you can 
configure the application to look for 
DTED files to use as DEM sources. You 
can specify the locations for DTED0, 
DTED1, DTED2 DEM file. Use the up and 
down arrow to set the priority for the 
elevation files. 
 

Adding a directory: 

1. Left click the [Add] button. 

2. Select the local “Demo Data” root 
directory. 

3. Left click the [OK] button in the “Browse 
For Folder” dialog. 
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Settings – Terrain  
continued 

Removing a directory: 

1. Left click the local “Demo Data”. 

2. Left click the [Remove] button. 
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Settings – Pixel Cursor 

The Pixel Cursor properties provides you 
with the ability to configure the look of 
the cursor. The cursor has an Inner Color 
and an Outer Color, as well as a Size 
(Small, Medium, or Large). 
 

Modifying the cursor: 

• Inner Color: Red 

• Outer Color: Yellow 

• Size: Large 
 

* For best visibility of the cursor, set the 
inner color and outer color to be highly 
contrasting. 
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Settings – Display 

The Display properties provides you 
with the ability to configure the 
default image orientation for the 
viewers. 
 

Image Display: 
• Image is Up orients the image such 

that the columns of the image are 
aligned with the columns of the 
viewer. 

• North is Up orients the image in 
the viewer so that the direction to 
North, as determined by the spatial 
reference system, is aligned with 
the columns of the viewer. 

• Z is Up orients the image so that 
vertical changes in elevation, such 
as the vertical lines of tall buildings, 
are aligned with the viewer.  
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Settings – Gridlines 

The Gridlines properties provides you 
with the ability to configure the default 
appearance of the geospatial grid 
overlay. 
 

Modifying Gridlines: 

Grid Lines: 

– Line Color: Green 

– Line Style: Dashed 

– Major Line Weight: 5 

Labels: 

– Label Color: White 

– Font: Arial 

– Size: 12 

– Label Format: DDDMMSS.S 
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Settings – Region of Interest (ROI) 

The ROI properties provides you with 
the ability to configure the default 
appearance of the region of interest. 
 

Modifying the ROI: 

• Line Color: Yellow 

• Line Weight: 1 

• Line Style: Dotted 
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Settings – Footprints 

The Footprints properties provides you 
with the ability to configure how DPPDB 
footprints are displayed in the viewer. 
You can specify the Line Color, Line 
Style, and Line Weight for both the 
Controlled Footprint and the 
Uncontrolled Footprint of a DPPDB 
segment.  
 

Modifying the Footprints: 
Controlled Footprint: 

– Line Color: Yellow 
– Line Weight: 10 
– Line Style: Solid 

Uncontrolled Footprint: 
– Line Color: Red 
– Line Weight: 2 
– Line Style: Solid 

 

9/21/2015 

UNCLASSIFIED 37 



I A V O  R E S E A R C H  A N D  S C I E N T I F I C  

®2015 IAVO Research and Scientific 

UNCLASSIFIED 

Settings – Mensuration Tools 

The Mensuration Tools properties 
provides you with the ability to 
configure how mensuration annotations 
appear. You can specify the default look 
and feel of the mensuration tools by 
specifying the Font parameters and 
Effects, as well as the Foreground and 
Background colors for the text. You can 
also specify the Line Properties of the 
mensuration vector components. 

9/21/2015 

UNCLASSIFIED 38 



I A V O  R E S E A R C H  A N D  S C I E N T I F I C  

®2015 IAVO Research and Scientific 

UNCLASSIFIED 

Settings – Point 

The Point settings properties provides 
you with the ability to configure how 
point annotations appear. You can 
specify the default Color, Weight, and 
Style for the Point annotation. 
 

Modifying the Point: 

• Point Color: Aqua 

• Point Weight: 1 

• Point Style: Solid 
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Settings – Point Marker 

The Point Marker settings control how 
the point vector appears for the point 
marker annotation. The textbox portion 
of the annotation object is controlled via 
the Textbox settings. 
 

Modifying the Point Marker: 

• Marker Color: Red 

9/21/2015 

UNCLASSIFIED 40 



I A V O  R E S E A R C H  A N D  S C I E N T I F I C  

®2015 IAVO Research and Scientific 

UNCLASSIFIED 

Settings – Polygon 

The Polygon properties provides you with the 
ability to configure how polygon annotations 
appear. You can specify the default look and 
feel of the polygon annotations by specifying 
the Line Properties of the vector components. 
You can also specify whether the Show 
Endpoint Direction and Show Centroid. The 
Fill Color can also be specified here. 
 

Modifying the Polygon: 

Line Properties: 

• Line Color: White 

• Line Weight: 2 

• Line Style: Solid 

• Show Endpoint Direction: Unchecked 

• Show Centroid: Unchecked 

Fill Properties: 

• Fill Color: Purple 
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Settings – Polyline 

The Polyline properties provides you 
with the ability to configure how 
polygon annotations appear. You can 
specify the default look and feel of the 
polygon annotations by specifying the 
Line Properties of the vector 
components. You can also specify 
whether to Show Endpoint Direction. 
 

Modifying the Polyline: 
• Line Color: Yellow 
• Line Weight: 10 
• Line Style: Solid 
• Show Endpoint Direction: Unchecked  
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Settings - Target 

The Target properties provides you with 
the ability to configure how target circle 
annotations are initially constructed. 
You can specify the Marker Color for the 
annotation object delineating the center 
of the target annotation.  Here, you can 
also specify parameters for the default 
rings, including the Damage Ring Units, 
and the initial Radius and Colors for the 
ring annotations. 
 
Modifying the Target: 
• Marker Color: Red 
• Damage Ring Units: Meter 
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Settings – Target  
continued 

Adding a damage ring: 
1. Left click the [Add Ring] button. 
2. Define ring parameters: 

– Radius: 100 
– Color: Green 

 
Removing a damage ring: 
• Left click the [Remove] button to the 

corresponding ring you would like to 
remove.  
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Settings – Textbox 

The Textbox properties provides you 
with the ability to configure the Font, 
Effects, and Color parameters for both 
standalone textbox annotations, as well 
as textboxes that appear as a 
component in complex annotations 
(e.g., point markers,  target rings). The 
Line Properties are used for both the 
textbox border, as well as any necessary 
callout lines for complex annotations. 
 
Modifying a Textbox: 
Font Properties: 

– Font: Arial 
– Font Style: Regular 
– Size: 14 

Color Properties: 
– Foreground: Black 
– Background: Yellow 

Line Properties: 
– Color: Red 
– Style: Solid 
– Weight: 1 
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Saving Settings 

All changes made to the settings are 
saved on a per-user basis, allowing all 
users on the same system to customize 
the look and feel of the software. 

 

Saving Settings: 

• Left click the [OK] button to save the 
changes. This will also close the dialog 
and take you back to the Main 
application.  
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Questions? 
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Module 2: IApioneer 
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Analysis 

You must select an annotation layer 
(.gad) to utilize the Analysis functionality 
within IApioneer. 
 

Selecting the Annotation Layer: 

1. Left click the [Layer Manager] button to 
see all layers within the current session. 

2. Left click the option button, to the right 
of the annotation layer, that you would 
like to edit. 

3. The “Analysis” Tab will display exposing 
the functionality to edit the active layer.  
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Displaying an image in the viewer 

Displaying an image into a viewer: 

1. Mouse over an image, in the Image 
Gallery, to see the image name. 

2. Right click image “SA1_058_58_hr4.tif”. 

3. Left click the [Send to Left Viewer] 
menu item. 
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Maximizing Your Workspace 

Hiding the layer Manager: 

• Left click the [Layer Manager] button. 
 

Hiding the image gallery: 

• Left click the spacer between viewers 
and image gallery. 

 

Hiding the right viewer: 

1. Mouse over the vertical bar between 
the left and right viewer. The cursor 
should turn into a left and right arrow. 

2. Left click and hold the vertical bar 
between the left and right viewer. 

3. Drag the mouse to the right portion of 
the right viewer. 

4. Release the left mouse button.   
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Accessing Analysis Capabilities 

Left click the “Analysis” tab to access 
the Analysis capabilities from within 
IApioneer. 
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Drawing a Polygon 

Drawing a polygon: 

1. Left click the [Shapes] button. 

2. Left click the [Polygon] menu item to 
activate the Polygon tool. 

3. Left click the starting point in the image 
to start drawing. 

4. Move the mouse to your second 
location and left click to pin. 

5. Move the mouse to the third location 
and left click to pin.  

6. Right click in the viewer to stop 
drawing. 
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Modifying a Polygon 

Modifying a polygon: 

1. Left click the previously drawn polygon 
to select it.  

2. Right click in the selected polygon. 

3. Left click the [Properties] menu item. 

4. Set the line properties to: 

– Line color: Red 

– Line Weight: 5 

– Line Style: Solid 

5. Set the fill properties to: 

– Fill Color: Transparent 

6. Left click the [OK] button. 
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Mensuration Information of a Polygon 

1. Left click the polygon to select it.  

2. Right click in the selected polygon. 

3. Left click the [Properties] menu item. 

4. Left click the “Mensuration” tab. 

5. Left click the [OK] button. 
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Drawing a Rectangle 

Drawing a rectangle: 

1. Left click the [Shapes] button. 

2. Left click the [Rectangle] menu item. 

3. Left click and hold, at the first point, in 
the image to start drawing. 

4. Drag the mouse to your second 
location. 

5. Release the left mouse button.   
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Modifying a Rectangle 

Modifying a rectangle: 

1. Left click the previously drawn polygon 
to select it.  

2. Right click in the selected polygon. 

3. Left click the [Properties] menu item. 

4. Set the line properties to: 

– Line color: Yellow 

– Line Weight: 5 

– Line Style: Solid 

5. Set the fill properties to: 

– Fill Color: Transparent 

6. Left click the [OK] button. 
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Subdivide 

IApioneer has the ability to subdivide a 
convex quadrilateral into a number of 
regularly sampled rows and columns. 
 

To subdivide a quadrilateral: 
1. Create a new convex four-sided 

polygon. 
2. Left click inside the polygon to select it. 
3. Right click the selected polygon.  
4. Left click the [Subdivide] menu item.  
5. Use the up-down arrows to adjust the 

number of rows and columns. 
6. Left click the [Apply] button to finalize 

the subdivision. 
 

* This is a great way to regularly sample 
a grid, including the centroids for every 
sub –region. 
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Drawing an Ellipse 

Drawing an Ellipse: 

1. Left click the [Shapes] button. 

2. Left click the [Ellipse] menu item. 

3. Left click and hold , at the first point, in 
the image to start drawing. 

4. Drag the mouse to your second 
location.  

5. Release the left mouse button.   
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Modifying an Ellipse 

Modifying an ellipse: 

1. Left click the previously drawn ellipse to 
select it.  

2. Right click in the selected ellipse. 

3. Left click the [Properties] menu item. 

4. Set the line properties to: 

– Line color: Yellow 

– Line Weight: 5 

– Line Style: Solid 

5. Set the fill properties to: 

– Fill Color: Transparent 

6. Left click the [OK] button. 
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Drawing a Point 

Drawing a Point: 

1. Left click the [Shapes] button. 

2. Left click the [Point] button. 

3. Left click in the image.  
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Drawing a Line 

Drawing a line: 

1. Left click the [Shapes] button. 

2. Left click the [Polyline] menu item. 

3. Left click where you would like the line 
to start. 

4. Move the mouse to the next location 
and left click to pin. 

5. Repeat step 4 as many times as you 
need to detail the line. 

6. Right click in the image to stop drawing. 
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Adding a Text Box 

Adding a text box: 

1. Left click the [Shapes] button. 

2. Left click the [Text Box] button. 

3. Left click in the viewer where you would 
like to place the text box. 

4. Type “Red Hat Amphitheater” into the 
text box. 

5. Left click outside of the textbox to 
update textbox and end editing of the 
text. 

 

Note: The textbox does not grow or 
shrink with the text being entered. The 
textbox will size to text, once you end 
the editing of the text. 
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Modifying a Text Box 

Modifying a text box: 

1. Left double click the textbox. 

2. Type “Amphitheater” into the text box. 

3. Left click outside of the textbox to 
update textbox and end editing of the 
text. 

 

Note: The textbox does not grow or 
shrink with the text being entered. The 
textbox will size to text, once you end 
the editing of the text. 
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Adding a Point Marker 

Adding a Point Marker: 

1. Left click the [Shapes] button. 

2. Left click the [Point Marker] menu item. 

3. Left click object within the viewer. 
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Adding a Targeting Circle 

Adding a Targeting Circle: 

1. Left click the [Shapes] button. 

2. Left click the [Target Circles] menu item. 

3. Left click the target. 
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Adding a North Arrow 

Adding a North Arrow: 

1. Left click the [Shapes] button. 

2. Left click the [North Arrow] menu item. 

3. Left click in the image. 
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Separation Angle 

Determine the separation angle from 
two geospatial lines.  

1. Left click the [Separation Angle] button. 

2. Left click in the viewer to pin the fist 
point. 

3. Move the mouse to the pivot point and 
left click to pin it.  

4. Move the mouse to the third point and 
left click to pin it. 

 

This will produce the separation angle 
displaying the degrees of separation. 
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Length 

Determine distance based upon two 
geospatial points. 

1. Left click the [Length] button. 

2. Left click the start of the object that you 
want to measure. 

3. Move the mouse and left click the end 
of the object. 

 

The line will be drawn with identifying 
distance displayed.  
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Counting Tool 

Assists in the counting of various 
features within the image. 

1. Left click the counting tool. 

2. Left click the green plus sign in the 
Counting tool dialog. 

3. Left click on the object that you would 
like to count. 

4. Repeat step 3 until all objects are 
accounted for.  

5. Counting tool will tally up the number 
of objects you have clicked. 

6. Left click the [X], in the upper right 
corner of the counting tool dialog, to 
close the counting tool. 
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Saving Annotations 

Lets make sure that you don’t lose your 
work. 

Saving an annotation layer: 

1. Left click the “File” tab to get to the 
backstage. 

2. Left click the “Raleigh.gad*” file to 
select it. 

3. Right click the selected “Raleigh.gad*” 
file to display the context menu. 

4. Left click the [Save Data] menu item. 
 

An asterisk should display on any files 
that have changes pending. The asterisk 
will disappear when the file is saved. 
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Questions? 
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Module 3: 3D Modeling 
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Keyboard Controls 

Key(s) Behavior 

CTRL Activate the last used creation state. 

CTRL+Z Undo or reverse the actions. 

CTRL+Y Redo the actions. 
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ESC Cancel the current drawing without creating an object. 

Backspace Removes the last vertex placed in an object. 

Shift Initiate snapping when close to another object. 

While not in active drawing mode 

While in active drawing mode 
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Navigating to the backstage 

Left click the “File” tab to navigate to the 
backstage. 

9/21/2015 

UNCLASSIFIED 75 



I A V O  R E S E A R C H  A N D  S C I E N T I F I C  

®2015 IAVO Research and Scientific 

UNCLASSIFIED 

Loading a Session 

Open Session: 

1. Left click the [Open Session] button. 

2. Left click the “Raleigh.xpj” file. 

3. Left click the [Open] button. 
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Loaded Session 
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Vector 

You must select a vector layer (.gvf) to 
utilize the FeatureXtract functionality 
within IApioneer. 
 

Selecting the Vector Layer: 

1. Left click the “Home” tab.  

2. Left click the [Layer Manager] button to 
see all layers within the current session. 

3. Select the option button to the right of 
the vector layer (.gvf) that you would 
like to edit. 

 

The “Vector” Tab should display 
exposing the functionality to edit the 
active layer.  
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Displaying an image in the viewer 

Displaying an image into a viewer: 

1. Mouse over an image, in the Image 
Gallery, to see the image name. 

2. Right click image “SA1_058_58_hr4.tif”. 

3. Select the [Send to Left Viewer] menu 
item. 

4. Right click image “SA1_058_59_hr4.tif”. 

5. Select the [Send to Right Viewer] menu 
item. 

 

Note: notice the arrow to the left of the 
image in the image gallery. The arrow icon 
indicates which viewer the image is being 
displayed.  

 

9/21/2015 

UNCLASSIFIED 79 



I A V O  R E S E A R C H  A N D  S C I E N T I F I C  

®2015 IAVO Research and Scientific 

UNCLASSIFIED 

Maximizing Your Workspace 

Hiding the Annotation Layer: 
• Left click the checkbox to the right of 

the “Raleigh.gad”. 
 

Hiding the layer Manager: 
• Left click the [Layer Manager] button. 
 

Hiding the image gallery: 

• Left click the spacer between 
viewers and image gallery. 
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Double check your source DEM 

If you have a DEM use it. However, a 
DEM is not required for modeling within 
FeatureXtract. 
 

Selecting a Source DEM: 

1. Left click the “Home” tab. 

2. Left click the source DEM dropdown. 

3. Select the available DEM. 
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Camera Locking 

Camera locking is used to geographically 
link the viewers so that movement (pan 
and zoom) in one corresponds to 
movement in the other.  
 

Locking the cameras: 

• Left click the [Camera Lock] button. 
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Shape Creation  
(Draw Polygon Tool) 

The draw polygon tool allows you to create 
a more complex polygon. Every point that 
defines that polygon will need to be 
pinned.  
 

Create a polygon with the Draw Polygon 
tool: 
1. Left click the [Polygon] dropdown button. 
2. Left click [Draw Polygon] to enable. 
3. Left click in the upper-left corner of the 

polygon. 
4. Left click in the lower-left corner of the 

polygon. 
5. Left click in the lower-right corner of the 

polygon. 
6. Left click in the upper-right corner of the 

polygon. 
7. Right click in viewer to end drawing mode.  
 

Note: notice the shape icon above the 
polygon dropdown button indicating the 
current drawing mode. 
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Shape Creation Results  
(Draw Polygon Tool) 
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Shape Creation  
(Draw Box Tool) 

The draw box tool is used to create a 
rectilinear polygon. Every polygon edge  
meets at a right angle.  
 

Create a polygon with the Draw Box tool: 

1. Left click the [Polygon] dropdown button. 

2. Left click [Draw Box] to enable. 

3. Left click in the upper-left corner of the 
polygon. 

4. Left click in the upper-right corner of the 
polygon. 

5. Left click in the lower-right corner of the 
polygon. 

6. Right click in the viewer to end drawing 
mode.  

 

Note: notice the shape icon above the 
polygon dropdown button indicating the 
current drawing mode. 
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Shape Creation Results 
 (Draw Box Tool) 

86 
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Shape Creation (Draw Ellipse Tool) 
 

The draw ellipse tool is used to create 
an Ellipse. Five points are required  to 
construct an ellipse.  
 

Create an Ellipse with the Draw Ellipse 
tool: 

1. Left click the [Ellipse] dropdown button. 

2. Left click [Draw Ellipse] to enable. 

3. Left click on the perimeter of the 
ellipse. 

4. Repeat step 3 four times. 
 

Note: notice the shape icon above the 
Ellipse dropdown button indicating the 
current drawing mode. 
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Shape Creation Results 
(Draw Ellipse Tool) 

88 
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Shape Creation  
(Draw Circle Tool) 

The draw circle tool is used to create a 
circle. Three points are required  to 
construct a circle.  
 

Create a Circle with the Draw Circle tool: 

1. Left click the [Ellipse] dropdown button. 

2. Left click [Draw Circle] to enable. 

3. Left click on the perimeter of the 
ellipse. 

4. Repeat step 3 two times. 
 

Note: notice the shape icon above the 
Ellipse dropdown button indicating the 
current drawing mode. 

9/21/2015 

UNCLASSIFIED 89 



I A V O  R E S E A R C H  A N D  S C I E N T I F I C  

®2015 IAVO Research and Scientific 

UNCLASSIFIED 

Shape Creation Results 
(Draw Circle Tool) 
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Shape Creation  
(Line Tool) 

The line tool is used to create a multi-
segment line.  
 

Create a Line with the Line tool: 

1. Left click the [Line] button. 

2. Left click the start of the line. 

3. Left click the end of the line. 

4. Right click to end drawing mode. 
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Split Edge Tool 

Splits the currently selected edge by 
adding a vertex at the midpoint of the 
edge. 
 

Split line: 

1. Left click the line segment that you 
would like to split. 

2. Left click the [Split Edge] button. 
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Combining Shapes  
(Union) 

Union shapes: 

1. Left click inside the boundaries of the 
first shape you would like to combine. 

2. Hold the down shift key and left click 
the second shape you would like to join. 

3. Left click the [Combined Shapes] 
button. 

4. Left click the [Union] button. 
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Combining Shapes Results 
(Union) 
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Combining Shapes  
(Subtraction) 

Ordering is Key! The polygon is the 
shape we want to alter and keep. The 
circle is going to be used to cut into the 
polygon.  
 

Subtracting shapes: 

1. Left click inside the boundaries of the 
polygon. 

2. Hold down the shift key and left click 
the circle then release the shift key. 

3. Left click the [Combined Shapes] 
button. 

4. Left click the [Subtract] button. 
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Combining Shapes Results 
(Subtraction) 
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Loft Feature 

Loft a selected polygon to a selected 
point, or loft two selected polygons. 
Polygon to polygon requires the same 
number of points.  
 

Polygon to Polygon: 

1. Select both polygons with the selection 
box. 

2. Left click the [Loft Feature] button. 
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Loft Results 
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Hipped Roof 

Creating a hipped roof: 

1. Create a polygon outlining the roof. 

2. Left click the polygon to select it. 

3. Left click the [Hipped Roof] button. 

4. Provide the Hipped roof parameters: 

– Height: 1.7 

– Ridgeline Offset: 0 

– Lock Hip Values: Unchecked 

– Left Hip: 4.5 

– Right Hip: 0 

– Roof Axis: Long Axis 

5. Left click the [OK] button to create the 
roof. 
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Domed Roof  

Domed Roof 

1. Left click the [Ellipse] dropdown button. 

2. Left click [Draw Circle]. 

3. Left click a point on the image circle 
object boundaries. 

4. Left click another point on the image 
circle object boundaries. 

5. Left click another point on the image 
circle object boundaries. 

6. Left click within the circle boundaries to 
select the circle. 

7. Left click the [Dome] button from 
within the roof window. 
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Domed Roof 
Continued 

Create Dome: 

1. Input the height 5.4. 

2. Input the number of layers 20. 

3. Left click the [OK] button. 
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Jumping to Location 

This tool will reposition the camera to a point 
within the viewer. Use this tool if you know 
the coordinates of the object that you are 
going to model.   
 

Jump to Location: 

1. Left click the [Jump to Location] button. 

2. Left click the coordinate system and select 
“Geographical Lat/Long”. 

3. Enter the latitude “354625.721N”. 

4. Enter the longitude “0783802.021W”. 

5. Left click the [OK] button. 

6. Forward Mouse wheel to zoom to the object. 
 

Note: make sure the input format of the 
Lat/Long matches the format of your 
coordinates.  
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Modeling 

You can model in the left or right viewer. The 
right viewer was used for this example. 
 

Simple Modeling: 

1. Left click the “FeatureXTract” tab. 

2. Left click the [Polygon shape] button to 
activate the polygon tool. 

3. Left click the corner of the object.  

4. Repeat step 3 five times to completely outline 
the object. 

5. Right click in the viewer to complete the 
polygon and end exit drawing mode. 

 

Note: The polygon in the left viewer is not 
aligned to the house. This indicates that the 
elevation is not correct and will need to be 
manipulated.  
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Manipulation of an object 

Move Epipolar is moving the selected 
feature along the epipolar line defined 
by the camera sensor models. 
 

Moving Epipolar: 

1. Left click the [Move Epipolar] button. 

2. Left click and hold within the 
boundaries of the polygon that you 
would like to manipulate. 

3. Drag the polygon to where it is aligned 
with the building in the image. 

4. Release the left mouse button when 
you are satisfied with the placement of 
the polygon. 

5. Now the two polygons are aligned to 
the building within the image. 
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Object from 2D to 3D  

Now that we have a 2D shape of the top 
of the building. We can transform the 
2D object to a 3D object with the 
Extrude feature. 
 

Extrude Polygon: 

1. Left click within the polygon that you 
want to extrude.  

2. Left click the [Extrude Polygon] button. 

3. Left click the [Planar Extrusion] button. 
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Selecting a face of a 3D object. 

Selecting a face:  

1. Left click inside the boundaries of the 
polygons. 

2. Left click the first “Polygon Feature” 
displayed in the “Select Feature” dialog. 

3. Left click the [OK] button. 
 

Note: left clicking the “Polygon Feature” 
will select the polygon face within the 
selected viewer.  
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Saving Vectors 

Lets make sure that you don’t lose your 
work. 
 

Saving a vector layer: 

1. Left click the “File” tab to get to the 
backstage. 

2. Left click the “Raleigh.gvf*” file to select 
it. 

3. Right click the selected “Raleigh.gvf*” 
file to display the context menu. 

4. Left click the [Save Data] menu item. 
 

An asterisk should display on any files 
that have changes pending. The asterisk 
will disappear when the file is saved. 
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Exporting Vectors 

You have the ability to export vectors to 
other formats.  

1. Left click the “File” tab. 

2. Left click the Vector (.gvf) that you 
would like to export. 

3. Right click the selected vector file from 
step 2.  

4. Left click the [Export] menu item. 
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Exporting Vectors - Continued 
 

Select the output format.  

1. Select the desired Output Format. 

2. Left click the […] button. 

3. Provide the name of the file. 

4. Left click the [Export] button. 
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Questions? 

9/21/2015 

UNCLASSIFIED 110 


